
1 

 

 

 

 

      

Libero SoC 導入編トレーニング演習資料 

                                   PolarFire SoC Discovery Kit 版 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



2 

 

内容 

はじめに ............................................................................................................................... 3 

環境 ...................................................................................................................................... 3 

サンプルデザイン ................................................................................................................ 3 

演習の概要 ........................................................................................................................... 3 

Help について ...................................................................................................................... 4 

演習 1  Libero SoC の起動 ................................................................................................. 5 

演習 2  新規プロジェクト作成 ........................................................................................... 6 

演習 3  デザイン入力 ........................................................................................................ 11 

演習 4  ファンクション・シミュレーション(RTL シミュレーション) .......................... 19 

演習 5  論理合成 ............................................................................................................... 31 

演習 6  各種制約(ピンアサイン) ...................................................................................... 34 

演習 7  タイミング制約 .................................................................................................... 43 

演習 8  配置配線 ............................................................................................................... 50 

演習 9  解析(Verify Timing, Verify Power) ..................................................................... 52 

演習 10 書き込み ............................................................................................................... 55 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



3 

 

はじめに 

この資料は Microchip 社の Libero SoC を実際に触ってみて一通りの操作フローを 

理解することを目的とした演習資料です。 

 

環境 

使用する開発キット : PolarFire SoC Discovery Kit (MPFS-DISCO-KIT) 

※ 本演習では SoC のうち FPGA Fabric の部分のみを使用します。 

ツールバージョン : Libero SoC v2024.2 

言語 : Verilog もしくは VHDL 

 

サンプルデザイン 

・開発キット上の 50MHz クロックを用いカウントアップ 

・1 秒周期で 0000→0001→0010・・・と LED を点灯 

 

演習の概要 

Libero の起動、新規プロジェクトの作成、HDL デザインの作成、 

テストベンチファイルの作成、RTL シミュレーションの方法、論理合成、 

ピンアサイン、タイミングの制約方法、配置配線、デバイスへの書き込みなど 

Libero の操作を確認します。 

シミュレーション結果の確認やタイミングの解析、タイミングシミュレーション等は 

割愛します。 
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Help について 

 

Libero SoC 内には各所に Help ボタンがあり、不明点を確認可能です。 
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演習 1  Libero SoC の起動 

 

    デスクトップ上のショートカット、もしくは Windows のアプリケーション一覧より 

Libero SoC を起動します。 
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演習 2  新規プロジェクト作成 

 

2-1. 新規プロジェクト作成 

  スタート・ページ > “New” 

   

   もしくは Project > New Project 

   

 

2-2. Project name を設定します。 

    Project name:  top 

 

※ Libero SoC はプロジェクト作成時に最上位階層のデザイン名は指定しません。 

   プロジェクト作成後に最上位階層のデザインを指定します。 
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2-3. Project location を設定します。 

    お手元の PC のご都合の良いフォルダへ設定して下さい。 

    Project location:  C:\lab 

     

 

2-4. Preferred HDL type にて VHDL もしくは Verilog を選択し、Next > を押します。 
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2-5. Device Selection にてデバイスを選択します。 

  PolarFire SoC Discovery Kit (MPFS-DISCO-KIT)の場合 

  「MPFS095T-1FCSG325E」を選択し Next>を押します。 

 

    Part filter にて下記を設定することで一覧表示を絞り込みできます。 

Family Die Package Speed Range 

PolarFireSoC MPFS095T FCSG325 -1 EXT 
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2-6. Device settings ページにてデフォルトのまま Next>を押します。 

   

 

2-7. Add HDL source files ページにてデフォルトのまま Next>を押します。 
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2-8. Finish を押します。 

     

 

2-9. 意図した設定で Libero SoC プロジェクトが作成されたことを確認します。 
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演習 3  デザイン入力 

FPGA で動作させたいデザインを用意します。 

今回デザインは Verilog もしくは VHDL で作成します。 

 

3-1. 新規 HDL ファイルを作成します。 

    File > New > HDL 

 

    もしくは 

    Design Flow タブ内の Create HDL をクリックします。 
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3-2. 新規に作成する HDL ファイルについて設定します。 

HDL Type :  Verilog もしくは VHDL を選択 

Name:  top 

Initialize file with standard template:  チェックを外す 

設定後 OK ボタンを押します。 

 

 

\hdl フォルダ下に空の HDL ファイルが生成されます。 
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3-3. デザインを入力します。 

     

Verilog の場合 

// top.v 

 

module top( 

  input clk50MHz, 

  input rst, 

  output reg [3:0] LED 

); 

 

reg [25:0] cnt; 

 

// 50MHz = 20ns 

// 1Hz = 1,000,000,000ns 

// 1,000,000,000ns / 20ns = 50,000,000 

 

always @(posedge clk50MHz or negedge rst) begin 

    if (rst == 0) begin 

        cnt = 0; 

        LED = 0; 

        end  

    else if (cnt == 26'd49999999) begin 

        cnt = 0; 

        LED = LED + 1; 

        end  

    else begin 

        cnt = cnt + 1; 

        LED = LED; 

    end 

end 

 

endmodule 
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VHDL の場合 

-- top.vhd 

library IEEE; 

use IEEE.std_logic_1164.all; 

use IEEE.std_logic_unsigned.all; 

 

entity top is 

port(   clk50MHz : in std_logic; 

        rst : in std_logic; 

        LED : out std_logic_vector(3 downto 0) 

    ); 

end top; 

 

architecture RTL of top is 

    signal cnt : std_logic_vector(25 downto 0); 

begin 

    -- 50MHz = 20ns 

    -- 1Hz = 1,000,000,000ns 

    -- 1,000,000,000ns / 20ns = 50,000,000 

 

    process(clk50MHz, rst) 

    begin 

        if rst = '0' then 

            cnt <= (others => '0'); 

            LED <= (others => '0'); 

        elsif clk50MHz'event and clk50MHz = '1' then 

            if cnt = "10111110101111000001111111" then 

                cnt <= (others => '0'); 

                LED <= LED + 1; 

            else 

                cnt <= cnt + 1; 

                LED <= LED; 

            end if; 

        end if; 

    end process; 

end RTL; 
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3-4. 入力したデザインを Save します。 

    Ctrl + S  

    もしくは 

top.v のタブ上で右クリックします。 

     

 

3-5. Check HDL File にて入力したデザインをチェックします。 

    もしエラーが出る場合は訂正し、再確認します。 
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3-6. Design Hierarchy タブを開きます。 

Build Hierarchy ボタンを押し Libero SoC プロジェクト内のデザインファイル階層を 

更新します。 

 

3-7. work 下のファイル top(top.v) [work]を右クリックし 

    Set as Root をクリックします。 

 

     

top.v が最上位階層のファイルとして設定され 

黄色い Please select a root 表示が消えます。 
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    注意 :  

  Set as Root 設定は忘れないようご留意ください。 

  未設定状態の場合、ピンアサインやタイミング制約を行うための 

Manage Constraints をダブルクリックしても画面が点滅するのみで何も開きません。 

   

 

 

 

Set as Root 指定についてのご参考 

 

最上位階層のデザインを指定(Set As Root)するには work 下のデザインファイルを 

指定する必要があります。User HDL Source Files 下のファイルを右クリックしても 

Set As Root は表示されません。 
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作成したファイル内が白紙の状態で Design Hierarchy を押しても 

work 下に HDL ファイルは表示されません。 

白紙の場合 :  

 

デザインがある場合 : 

 

 

 

文法エラーがある状態では最上位階層のデザインを指定(Set As Root)できません。 
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演習 4  ファンクション・シミュレーション(RTL シミュレーション) 

今回のデザインは目視できるよう 1Hz で LED をカウントアップしています。 

1Hz のシミュレーション確認は時間がかかるため、 

今回は簡易的に、テストベンチからの SYSCLK 入力に応じて 

内部信号でカウンターがカウントアップしていることを確認します。 

 

4-1. テストベンチファイルを作成します。 

     Design Flow タブを開きます。 

Create HDL Testbench をクリックします。 

      

 

4-2. 作成する HDL について設定し、OK を押します。 

     HDL Type : Verilog もしくは VHDL を選択 

     Name: top_tb 

     Clock Period(ns): 20 

     チェックボックスはチェックが入ったままの状態にします。 
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\stimulus フォルダ下にテストベンチが生成されます。 

Clock Period に応じたクロックや、最初のリセット入力等は予め記載されています。 

 

Verilog の場合 

      

     VHDL の場合 
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     本来はデザインに対するテスト項目を検討し対応するテストベンチを作成します。 

今回は開発フローの確認を目的としているので割愛し、本ファイルをそのまま 

使用します。 

 

 

4-3. Stimulus Hierarchy タブを開きます。 

Build Hierarchy をクリックします。 

     

  階層情報が更新されます。(以下は Verilog の場合のスクリーンショット) 
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4-4. work 下のテストベンチ、 

top_tb を右クリックし Set as archive stimulus を選択、 

テストベンチとして設定します。 

 
 

テストベンチファイルの左側に波形のマークがつきます。 
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4-5. Design Flow タブを開きます。 

    Verify Pre-Synthesized Design 下の Simulate を右クリックし 

Open Interactively をクリックします。 

     

  ModelSim が起動し、シミュレーションが始まります。 

    テストベンチのクロック入力やリセット入力を確認可能です。 
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4-6.  下位(テストベンチ下のデザイン)信号の追加 

(1) 視認性のため仕切り線を追加します。 

         Wave ウィンドウ左側、何もない部分を右クリック、Add > New Divider を 

クリックします。 

 

 

    (2) Wave Divider Properties ウィンドウにて OK を押します。 

 

New Divider が挿入されます。 

 

 

 

 

 

 

 



25 

 

    (3) 左側の sim ウィンドウにて top_0 を選択します。 

        Objects ウィンドウにて top.v もしくは top.vhd の信号が表示されます。 

 

 

       Objects 内の信号を全選択します。 
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       信号を選択している状態で右クリック、Add Wave をクリックします。 

        

 

       Wave – Default ウィンドウに top.v もしくは top.vhd の信号が表示されます。 
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    (4) シミュレーションが既に始まっているので一度リセットします。 

        Transcript にて restart と入力 

     

    もしくは Simulate > Restart... をクリックします。 

     
    Restart ウィンドウが表示されるのでそのまま OK を押します。 
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    (5) Transcript にて run -all と入れ、シミュレーションを再スタートします。 

 

 

    (6) 波形の拡大縮小、全体表示は虫眼鏡マークから可能です。 

 

 

数字を見にくい場合は信号名を右クリックし Radix より任意の数値表現へ 

変更可能です。 
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   (7) cnt 信号が 0000001→0000002→0000003・・・とカウントアップしている 

ことを確認します。 

 

 

ご参考 

今回は割愛しましたが、しばらく待つと LED が 1 秒周期でカウントアップしていくことを

確認できます。 

 

1111 までカウントすると次は 0000 になります。 
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   (8) STOP を押しシミュレーションを止めます。 

 

 

   (9) Simulation > End Simulation をクリックしシミュレーションを終了します。  

    

 

 (10) ModelSim を閉じます。 
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演習 5  論理合成 

Design Flow タブ内の Synthesize をダブルクリックし、論理合成します。 

     

 

    論理合成が完了すると、左側に緑のチェックマークが表示されます。 
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        論理合成したデザインがどのくらい FPGA リソースを使用しているかは 

Reports ウィンドウの Synthesize 内、top_compile_netlist_resource.xml を選択し 

    Compile Report を見ると確認可能です。 
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ご参考 

論理合成後に polarfire_syn_comps.v に対して表示されている 

User defined pragma syn_black_box detected ワーニングについて 

 

→ 本ワーニングは安全に無視できるものになります。 

 

 

 

 

polarfire_syn_comps.v ファイルには Synopsys の認識していない、 

PolarFire プリミティブ用のタイミング情報を持ったモジュール宣言が含まれています。 

なお、本ファイルは全 PolarFire デザインに対し作成されます。 

 

polarfire_syn_comps.v はすべてのモジュールに対して'syn_block_box' attribute を使用して

いるので syn_black_box が検出された旨の CG100 : User defined pragma syn_black_box 

detected ワーニングが表示されます。 
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演習 6  各種制約(ピンアサイン) 

クロック入力、リセット入力、LED をピンアサインします。 

 

6-1. Libero にて左側の Design Flow タブを開き、Manage Constraints を 

ダブルクリックします。 
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6-2. I/O Attributes タブを開き、Edit 右側の▼をクリックし、 

Edit with I/O Editor をクリックします。 

    

 

 

ご参考 

I/O Editor を開く場合、事前に論理合成(Synthesize)が必要です。 

 

未実施の場合 Edit with I/O Editor をクリックすると下記ウィンドウが出るので、 

論理合成(Synthesize)を実施します。 
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6-3. バンク電圧の設定方法を確認します。 

    今回はバンク 0 を 1.8V に固定します。 

     

    (1) I/O Bank Settings を開きます。 

         

 

    (2) Choose Bank にて Bank 0 – HSIO を選択、 

    VDDI にて 1.8V を選択します。 

    右上の Locked へチェックを入れます。 

        

 

   (3) OK を押し I/O Bank Settings ウィンドウを閉じます。 
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6-4. I/O Editor にて下記表の通りピンアサインを行います。 

      

開発キット上の 

ペリフェラル 

信号名 ピン番号 バンク 

50MHz Oscillator clk50MHz R18 Bank0 

LED1 LED[0] T18 Bank0 

LED2 LED[1] V17 Bank0 

LED3 LED[2] U20 Bank0 

LED4 LED[3] U21 Bank0 

SW1 rst T19 Bank0 

 

     [方法 1  Pin View にて Ports を Pin へドラッグ&ドロップ] 

     Pin View タブを開きます。 

     左側 Main Object Browser にて Port タブを開きます。 

     Port を選択し、右側の Pin View へドラッグ&ドロップします。  
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     アサイン後 

      

      

   プルダウンでの選択も可能です。 
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     [方法 2  Port View にて Pin をプルダウンや手打ち] 

     Port View タブを開きます。 

     Pin Number にてプルダウンでピン番号を選択、もしくは手打ちでピン番号を 

入力します。 

 

 

     [ピンアサインを外したい場合] 

     誤ってピンアサインしたい場合やピンアサインを変更したい場合は 

   左側の Port 内にて Port を選択、右クリックし Unplace From location を 

クリックするとピンアサインを解除できます。 
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     Logic > Unplace All で一括解除もできます。 

      

 

6-5. Save します。 

     

 

6-6. I/O Editor を閉じます。 

     

     

    I/O Editor にて設定した内容で pdc ファイルが生成されます。 
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6-7. Place and Route 欄にチェックが入っていない場合はチェックを入れます。 

    

 

   Save します。 

 

 

Save 後、下記 Warning が表示された場合は OK を押します。 

 

 

  Save していない場合、Timing 等 他の操作をする際に下記エラーが出ます。 
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Discovery Kit のピンアサインについて 

開発キットのどのペリフェラルがどのピンかは、 

PolarFire SoC FPGA Discovery Kit User Guide 

に記載されています。 

https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocu

ments/UserGuides/PolarFire_SoC_FPGA_Discovery_Kit_User_Guide.pdf 

 

補足 

clk50MHz, rst, LED(今回の演習)は Bank 0 を 1.8V で使用しています。 

 

実際に開発される際は、プロジェクト作成時に Default I/O technology にて 

使用される予定の最大電圧を選択して下さい。 

 

 

参考 FAQ :  

I/O Editor のピン配置に関して。I/O Editor で"DDRIO"に割り当てられている端子に 

アサインできません。 実際は通常の LVCMOS2.5V で使用したいのですが「LVCMOS18」

しかリストされません。 

https://www.macnica.co.jp/business/semiconductor/support/faqs/microchip/136818/ 
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演習 7  タイミング制約 

タイミングの制約方法を確認します。 

 

7-1. (もし閉じている場合)ピンアサインで使用した Constraints Manager を開きます。 

     

 

7-2. Timing タブを開きます。 
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7-3. Edit 右側の▼から Edit Synthesis Constrains を選択します。 

 

 

7-4. ConstraintsEditor ウィンドウの Constraints から Clock...を選択します。 

  

 

7-5. Create Clock Constraint ウィンドウで下記のように設定します。 

  Clock Name: clk50MHz 

    Period : 20 
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7-6. Clock Source の...ボタンをクリックします。 

   

 

7-7. Select Source Pins for Clock Constraint ウィンドウにて 

    Search ボタンをクリックします。 
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7-8. clk50MHz を選択し Add をクリックします。 

   

 

7-9. Assigned Pins に clk50MHz が表示されていることを確認し 

  OK をクリックします。 
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7-10. Create Clock Constraint ウィンドウにて OK ボタンをクリックします。 

   

 

7-11. ConstraintsEditor ウィンドウにて Save ボタンを押します。 

      

 

7-12. ConstraintsEditor ウィンドウを閉じます。 
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      設定した内容に応じた sdc ファイルが生成されます。 

    

 

7-13. sdc ファイルをダブルクリックして開きます。 

      

 

7-14. 今回開発キット上の配線遅延が分からないので、set_input_delay や 

set_output_delay のタイミング制約は割愛します。 

代わりに create_clock のタイミング制約の下に set_false_path を追記します。 

create_clock の下へ追記 

set_false_path -from [ get_ports { rst } ] -to [ get_clocks { clk50MHz } ] 

set_false_path -from [ get_clocks { clk50MHz } ] -to [ get_ports { LED[*] } ] 

 

    sdc ファイルを Save します。 
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7-15. Constraint Manager の Timing タブを開き、 

     もしチェックが入っていない場合は Synthesis、Place and Route、 

Timing Verification にチェックを入れます。 

      

     Save を押します。 

      

     Warning が表示された場合は OK を押します。 

    

 

7-16. 論理合成(Synthesize)を行います。 
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演習 8  配置配線 

 

Place and Route をダブルクリックします。 

 

      配置配線が完了すると、Place and Route 左側に緑のチェックマークがつきます。 
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補足 

本日のトレーニングでは割愛していますが 

Verify Post Layout Implementation 内の Simulate を右クリック、 

Open Interactively をクリックするとタイミングシミュレーションを実施できます。 
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演習 9  解析(Verify Timing, Verify Power) 

 

9-1. Verify Timing 

    タイミング解析の操作を確認します。 

    Design Flow 内で Verify Timing をダブルクリックします。 

     

 

    完了すると Verify Timing の左に緑のチェックマークが表示されます。 
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  タイミング解析のレポートが表示されます。 

     

    未制約(タイミング制約不足)があるかどうかは 

    Reports の top_timing_constraints_coverage.xml にて確認できます。 
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9-2. Verify Power 

    消費電力解析操作を確認します。 

  Design Flow 内で Verify Power をダブルクリックします。 

     

  完了すると Verify Power 左側に緑のチェックマークが表示されます。 

   

レポートが表示されます。 
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演習 10 書き込み 

 

10-1. 開発キットを用意し、ケーブルを接続、PC と繋ぎます。 

    

 

10-2. (必要に応じて)既に PolarFire へ書き込まれているデザインを Erase します。 

     (1) Run PROGRAM Action を右クリックし、Select Action をクリックします。 
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 (2) Action のプルダウンで ERACE を選択し OK を押します。 

      

 

 (3) Run ERACE Action をダブルクリックし、Erase を実行します。 
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10-3. 書き込みの実施 

 

  (1) (10-2.にて Erase を実施した場合) 

        Design Flow 内の Run ERACE Action を右クリックし、 

        Action を PROGRAM へ切り替えます。 
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  (2) Libero の Design Flow 内で Run PROGRAM Action をダブルクリックします。 

       書き込みファイル生成～書き込みが完了まで待ちます。 
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10-4. LED1, LED2, LED3, LED4 がカウントアップしていくことを確認します。 

 

 

    SW1 ボタンを押し、カウントアップがリセットされることを確認します。 

 →  

 

 

 

以上 
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変更履歴 

 

リビジョン 日付 概要 

V1 2025 年 1 月 DiscoveryKit 版新規作成 

Set as Root 未設定時について注意追記 

IO バンク電圧設定の演習を追加  

V2 2025 年 3 月 ModelSim シミュレーション STOP についてスクリーンシ

ョット差し替え 

   

 

 

 

 

 

 

免責およびご利用上の注意 

1. 弊社より資料を入手されましたお客様におかれましては、下記の使用上の注意を一読いただいた上でご使用くださ

い。 

2. 本資料は予告なく変更することがあります。 

3. 本資料の作成には万全を期していますが、万一ご不明な点や誤り、記載漏れなどお気づきの点がありましたら、 

本資料を入手されました下記代理店までご一報いただければ幸いです。 

株式会社マクニカ ホームページ https://www.macnica.co.jp/ 

4. 本資料で取り扱っている回路、技術、プログラムに関して運用した結果の影響については、責任を負いかねますので 

あらかじめご了承ください。 

5. 本資料は製品を利用する際の補助的な資料です。製品をご使用になる際は、各メーカ発行の英語版の資料も 

あわせてご利用ください。 

 

 

 

 

 

 

 


